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About this guide: 
This guide contains only a minimum number of images. Please visit the CMS Training Website 
http://www.montgomerycollege.edu/Departments/cpod/cms/ for interactive demos of the 
procedures described in this guide. Pages 2-23 focus on the fundamental procedures 
required to set up Department 1 Template.  Pages 24-25 focus on setting up the Department 
2 Template.  Gray boxes inserted at strategic points in the outline contain steps for you to 
perform.  Material outside the gray boxes is informational.  This guide is also available for 
download at: http://www.montgomerycollege.edu/departments/cpod/cms/  

http://www.montgomerycollege.edu/Departments/cpod/cms/�
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Class Description (from the PDS) 
 
Category: Technology Resources     Subcategory: Web Development  
Primary Sponsor: CPOD  Secondary Sponsor: IT  
Target Audience: This class may only be taken by faculty and staff who have been approved to manage their 
department’s Web site. NOTE: This class does not cover how to create faculty pages with the new CMS.  
 
Prerequisites:  
You must have completed Steps 1-4 of the Office of Information Technology’s “Road Map” for Designing Your Web Site. 
Before signing up for this class, copy and paste the URL below into your browser and complete steps 1-4 of the Road 
Map. http://cms.montgomerycollege.edu/oit/NetworkAndComputing.aspx?id=5530  
 
Multiple Meeting Class: This class has more than one meeting. You must attend all of the meetings to receive credit or 
the certificate.  
 
Description  

This class is an introduction to the most essential skills required to create and maintain department Web sites using the 
Content Management System (CMS). On the first day of class, you will log into the CMS training folder where you will 
find personalized practice materials. The instructor will explain, demonstrate, and walk you through simple practice 
exercises for each of the skills.  

On the second day of class only those participants, for whom we have received approved CMS Web Site Request Forms, 
will be able to log into their department Web folders and begin creating content.  

IMPORTANT: Participants who have not submitted a form, and have not received approval (step 4 of the Road Map) will 
only have access to the training folder, and will not be able to complete the class. 

 
Key Outcomes 

• Access the Staging work-area and log into your department’s CMS account  
• Use Ektron CMS400 Web editor to style text according to the Montgomery College Web Site Style Guide  
• Create hyperlinks and bookmarks, and upload documents and images to your department folder  
• Create and style tables for layout and data display  
• Create the department header, menu, and main content areas  
• Publish Web content to your department’s official Web folder  

Pre-Class  “Road Map” Checklist 
 
• You have informed OIT of your department’s proposed Web design start-date. 
• You have developed a site-map and reviewed and updated written content for the site. 
• You have previewed the available templates and selected one. 
• You have submitted and had approved the OIT CMS Web Site Request Forms.  

http://cms.montgomerycollege.edu/oit/NetworkAndComputing.aspx?id=5530�
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How does the CMS differ from the Web sites you may have managed in the past?  
Traditional Web Design Concept 

• HTML page is a self-contained file in a folder on your compter or Web server:  
o Example path on your computer: C:\rootfolder\subfolder\filename.html or  
o Example path on the server:   http://www.domain.com/subfolder/filename.html  

• The page’s assets (images, media, links) are not part of the page, but are imported from their respective 
addresses using folder-pathnames.  
 

 

 

 

Content Management System – A Different Paradigm 
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Getting Started  

 
 Get Your User-name and Password from the CMS Instructor   

 
1. Class-day 1: Your temporary user-name and password.  (for example: user1, password1) 
2. Class-day 2: For those with approved OIT CMS Web Site Request Forms - your official user-name, 

department template type, department URL, department folder-path, and PW-change instructions. 
 

 Open the CPOD CMS Training Page, Log into the CMS “Staging” Site, and Open a CMS Example Page 

1. Open CPOD’s “Content Management System Training” page. 
http://www.montgomerycollege.edu/Departments/cpod/cms 
Become familiar with the contents. 

2. Copy this URL:   http://staging.montgomerycollege.edu/cmslogin.aspx 
3. Open a 2nd

4. When the page opens, Click the Login button (upper left.)  
 browser-tab & Paste the URL into the address bar. 

5. When the dialogue box opens,  
Enter your temporary ID & password and Click “Login.” 

6. Click OK when the alert pops up, redirecting you to EDU.  
7. The Staging Site MC EDU page will appear.  Wait until the page loads. 

There will be a yellow “Developer Toolbar” at the top. 
8. Copy/Paste this “Example Page” URL into its address bar: 

http://staging.montgomerycollege.edu/edu/department.aspx?id=5522 

NOTES: 

Briefly review the content areas on this example page.  

 
 Open the Web site editor - This is the application where you upload  

files to the Staging site, create and layout content for your pages,  
and publish content to the “Public” site.  
 

1. Click the “Workarea” button in the Developer Toolbar at the 
top of your page. 

2. A new browser will open on top of the Staging site browser.  
The new browser contains the Web editing software – Ektron 
CMS400.net (the eWebEditPro software)  

3. IMPORTANT:  Do not click anything on the editor’s “Smart 
Desktop” opening screen.  

NOTES: 

 
 Find your own practice folder for this class.  

 

1. Click the “Content” button in the lower left. 
2. The “Content Work-area” will open.    
3.  Use the folder-tree (upper left) to navigate to the folder for 

this class-date.   
 
EDU  Training  Class-date (dd-mm) 
 

NOTES: 

http://www.montgomerycollege.edu/Departments/cpod/cms�
http://staging.montgomerycollege.edu/cmslogin.aspx�
http://staging.montgomerycollege.edu/edu/department.aspx?id=5522�
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4. In the class-date folder, click on the sub-folder having your 
temporary user-name. 

5. Your “Workarea” folder opens with its content-blocks 
displayed in the right panel.  (Write down the ID number for 
“My Practice Content Block.” It’s in the 3rd column.) 

 
 Preview “My Practice Content Block” on the Staging Site.    

 

1. Return to the browser-tab containing the “Example Page”  
2. Replace the 4 numbers at the end of the URL with the ID 

no.  you wrote down. 
3. Hit ENTER on your keyboard to load the page. 
4. Temporarily save this page in Favorites – for this class. 
5.  Keep this browser tab open during your editing session. 

NOTES: 

 
 
 
 

 What Are Assets and Content Blocks    (Refer to the browser with the Ektron CMS400 editor open.)                             
In the editor, the right-hand panel of the Workarea displays your “Assets” and “Content Blocks”. 
 

• Assets:  are graphics  | media   | documents      you have uploaded to the CMS.   
IMPORTANT:  If you have media assets (video or audio) DO NOT attempt to upload them to the CMS. 
To use video or audio on your Web site you should take Podcast Builder training. 

• Content Blocks: are HTML data-base records   - HTML displays your text, hyperlinks and assets.  
 
 

 The Department 1 Template:  Three Basic Areas     (Refer to Staging Site browser with you practice content.) 
    

1.  The Department Header Area can contain up to 3 content-
blocks, each with unique ID, and each optional. 

• Department Banner Image 
• Department Title  
• Department  SubTitle  

 
 

2. The Department Menu Area (on the left.) It is not shown in 
the Workarea with your other content blocks but can be 
separately viewed and edited with the CMS editor. 
 

3. The Page Content Block (center-right) contains one content-
block ID at a time. This is the ID in the browser address field 
and it automatically loads the header and menu blocks. 

NOTES: 

 

  



Department Web Site Management with the CMS:  In Class Guide 6 

 

Understanding How the Web Editor Displays Three Views of Your Content 

Workarea Content-View:    
When you click on a content block title in the folder area, the 
Workarea Content View for that item will display.  This view 
shows the contents of the data-base record but not the text or 
image styles.  
 

 
Edit-View:   
When you open a content block in the editor. All of the text and 
image styles will be displayed, but since the editor is larger than 
the general web-page template for you content area, the general 
layout, including text-wrap of paragraphs, may be slightly 
different than it will be when previewed on the Staging or 
Production sites. 
  
“Staging Site” Preview and the 
‘Production Site” View 
These views will accurately 
represent your content. It is 
best to develop the habit of 
checking page layout on the 
Staging Site. 
 

 
 

 Creating a New HTML Content Block 
 

1. Roll over the  button in the upper left of the 
folder-view of the Workarea. 

2. Select HTML Content from the drop-down menu. 
3. The Editor opens  
4. Type a Title.  (This will be displayed on the browser tab.) 
5. Type a short sentence in the editing space below.  

6. Click  “Checkin”    (Saves and makes preview-able.) 
7. The folder view will redisplay in your Workarea Content. 

 
NOTE: We will explore the full explanation of the Publish, 
Checkin, Save, and Cancel buttons later. 

NOTES: 
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 Introduction to Text Styling           
You have selected your folder and the Workarea should be displaying your assets and content-blocks.  

 
 Opening a content-block in edit-mode 

 

1. Click on “My Practice Content Block” in the right panel of 
the Workarea. 

2. The “Workarea Content Viewing Panel” opens showing the 
content for the block you selected.  IMPORTANT:  This is not 
the editor.  It only displays the data-base record. 

3. Click the Edit button  in the upper left to open the 
content-block in edit-mode. 

4. The Editor opens  

NOTES: 

 
 Styling Standard Non-linked Text               

                                                                 
•   Before you can select a text-style, the text must be typed and selected.  Select by dragging your mouse 

over the text and highlighting it.   Once the text is highlighted you can make style selections from the “Apply 
Styles” drop-down menu, and size selections from the “size” drop-down menu next to it. 

• Producing Line Spacing:  Single-space = Shift/Enter,  Double-spacing = Enter (only) 
• Text Size Styles:  These styles will apply to all text between two double-spaced lines
• Text Color Styles:  These styles (and other toolbar styles) can be applied to any selected text. 

 
Color preferences from the MC Web Site Style Guide 

. (This is a default.) 

Dark gray is used for body copy  Light gray is used for visited links  
    
Medium Blue is used for links  Dark Blue is used for backgrounds & specialty table text  
    
Orange is used for page titles  Yellow is used for the text of feature headers over a 

dark blue background. 
 

    
Red is used as an alert color.    
The following image shows the text produced by selections in each drop-down menu.  
NOTE: Bold, Italic, Underline and other toolbar tools are covered in the Supplement to the Guidebook. 
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 Using The Undo and Redo Buttons 

 
 

• Undo – Cancels the previously entered command.   
• Redo -  Reapplies the changes from the command that occurred before you pressed “Undo.” 

 
• Examples of what is a “command” 

 
 The typing of text, spaces, line-feeds, regardless of the length, is considered a single command. 

If you have typed an entire paragraph, “undo” will erase the whole thing. 
 Applying a style is a single command.  The 1st “undo” removes the style and the 2nd

 Starting a bullet-list or a numbered-list is a single command. but adding text to it would be a 
subsequent command.  The 1

 undo 
removes the text (or the command that preceded the style. 

st “undo” deletes the text. The 2nd “undo” deletes the start of the 
list. 
 

PRACTICE  TEXT STYLING  
• “My Practice Content Block” should already be open in the Editor.  If not, please open it now. 
• Follow the instructions for “Practice Text Styling.” 
• When finished, click “Check-in.”  
• When the Workarea Content View appears, reselect your own folder for this class in order to view the list of 

content-blocks and assets it contains. 

 
Next we will cover how to preview your work in the Staging Site.  
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Previewing Your Content on the Staging Site                               
To preview content on the Staging site it must be (1) published or checked-in, (2) you must be logged in to the Staging 
site and it should be the browser on top.   
 

1. If “My Practice Content Block” is open in the Staging Site, skip to step 2.  
Otherwise, follow these instructions: 
 

a. Each content block is assigned a 4-digit ID. 
 Note the ID of your content block. 
 The four-digit ID number will be in the 3rd

b. Minimize the editor browser. (You should be able to see the Staging Site 
browser which was below the editor.)  

 column labeled ID - 
two columns to the right of its name. 

c. If the address field shows a 4-digit ID at the end, replace only those 4 
digits with the ID of your own content block and hit ENTER on your 
keyboard.   
 

NOTE: 
If the address field does not show a 4-digit ID at the end, paste or type the 
text below at the end and hit ENTER.  department.aspx?id=5522 
The whole address should look like this: 
http://staging.montgomerycollege.edu/edu/department.aspx?id=5522 

 
2. Preview Modes:  NO  and YES.   

When the Staging site initially loads, the Preview Mode (in upper right) is set to 
“NO.”   (See the right side of the Developer’s Toolbar.) 
 

3. When Preview Mode is set to NO:   
A blue bullet appears in the upper left of the content area.  If a previously 
“Published” version of your content exists, you will see it and the bullet. 

 
 If you have only “checked-in” your content-block and have not “Published” it, 
you will not see the new content, only the blue bullet.   

 
 

4. When Preview Mode is set to YES  
You can view both published and recently “checked-in” content. 
 

5. Set Preview Mode to YES  

a. Click the “Preview” button  in the Developer Toolbar.   
b. The Preview Mode will change to YES and the edited content will appear, 

without the blue bullet. 
 

 

http://staging.montgomerycollege.edu/edu/department.aspx?id=5522�
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Uploading Document and Image Assets    

Documents have file extensions like:  .doc, .docx, .xls, .xlsx, .pdf, Images have extensions like:  .gif, .jpg, .png 
 

How to upload single files 

1.  Navigate to the CMS folder where you will store the 
images, (currently your training folder.)  

2. Roll your mouse over the  button in the 
Workarea toolbar. 

3. Select DMS Document from the drop-down menu.  The 
upload dialogue box opens. (NOTE: DMS means “Document 
Management System.” Use “DMS Document” for literally all 
types of non-HTML documents and images.) 

4. Type a name in the Title field.  Type content-type first,    
for example: “Image – a photo of something”  

5. Click “Browse” to navigate to the file on your computer. 
The Windows file-dialogue box opens. 

6. Navigate to the folder where your file (CMS Training . . .) 
7. Select the file and Click “Open.” After clicking “Open” the 

choose-file box closes.   
8. Click the “Publish” button in the upper left of the editor in 

order to make the file available for preview.  NOTE:  “Check-
in” will save the document or image, but it won’t appear in 
preview-mode until the document or image is “published.” 

9. The screen will display “One Moment Please. . .” then . . .  
Your successful upload will be confirmed when the 
Workarea shows your image, or for a document, its 
download-icon and title.  (NOTE:  You can double-click the 
download-icon and retrieve the document from the CMS. 
Useful for people who co-manage your site.) 

NOTES: 

 
• How to upload multiple files at once 

1. Locate your folder where you will store the files. 

2. Click the “Add Assets” icon in the Workarea toolbar.  
3. The Drag and Drop window opens. 
4. Open Windows Explorer and reduce its size so you can see 

it and the editor’s Drag and Drop window at once. 
5. Multiple-select the files you wish to upload. (Ctrl-Click to 

select files that are non-consecutive. Shift-Click to select 
consecutive files.) 

6. Drag and Drop the files to the CMS Drag and Drop Window. 
7. Release the mouse button and wait for the files to be 

copied to the CMS. The data-base record names will be the 
file names. 

NOTES: 
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PRACTICE UPLOADING ASSETS (Examples are in the CMS Training Materials folder on your desktop.)                                                          
1. Upload an image and a document from the folder.   
2. When adding the title, type asset-type first, for example:   “Image – photo of me”) 
3. We will practice multiple file uploading on the 2nd day of the class. 

 

Inserting and Styling Images 
“My Practice Content Block” should already be open in the Editor.  If not, please open it now. 
We will be inserting images into text-areas. 

1. Click your mouse into the text at the location where you 
want to place the image. 

2. Click the “files, images, hyperlinks” icon   
3. The CMS Library for that folder will pop open in a separate 

browser.  It will show the images that have been stored 
there.  NOTE:  In Firefox this browser may appear behind 
your editor and you may have to select it using your 
Windows “quick-launch” bar. 

4. Double-click the image you want to insert. 
5. The “Picture Properties” dialogue box will appear. 
6. Type a title into the title field so that accessibility laws are 

satisfied.  
7. Click “Insert File” to place the image at the cursor location 

in your content. 
8. The Picture Properties dialogue box will close and the image 

will appear at the cursor location in your content. 

NOTES: 

 

Styling an Image                                                                          
The image must be placed into your content in order to style it. 
 

1. Click the image to select it.  You will see small handles 
surrounding the image and your mouse cursor will  
change to cross-hairs.  (May take a couple of tries.) 

2. Open the “Apply Styles” menu 
Notice that “ImageNoStyle” is the default.  This style will let 
you drag the image to any place on the screen, but text-
wrap defaults to “in-line

3. Styles “image-left” and “image-right” will force the image to 
one side of the content area and allow text to wrap around 
the other side.  

, meaning that text will not wrap 
around either side of the image.  

a. Select the Image, open “Apply Styles”, and  
select “image-left” or “image-right.” 

b. The image will jump to either the left or right margin, then 
drag the image to the vertical position you desire relative to 
the body of text.  The text will flow around it. 

EXAMPLE:

 
NOTES: 
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More elegant methods of content-layout will be covered later when in the discussion of “Using Tables” 
 

PRACTICE  INSERTTING AND STYLNG IMAGES                                                                                             
• Open “My Practice Content Block”  
• Follow the instructions for “Practice Inserting and Styling Images.” 
• When finished, click “Check-in” and then preview the content in the Staging Site. 

 

 
Adding Hyperlinks and Bookmarks      
Text or images can be hyperlinked to the following:  

• Web pages outside the CMS (external links),  
• Another MC Unit’s or Department’s CMS content block and document asset 
• Your other CMS content blocks and document assets, and to  
• “Bookmarks” . . . anchor-locations on your page to which hyperlinks can jump. 

 
 Creating a Link to an External (non-CMS) Web Page 

 

1. In the edit-mode, highlight the text or image that will 
become your link. 

2. Click the “Hyperlink icon”   A “Hyperlink” popup 
window will open. 

3. Make sure the “Type” field had “http:” selected. 
4. Enter the full URL in the “Link” field. (NOTE:  It is wise to 

open that URL in a separate browser copy the address, right-
click to copy it, then return to this dialogue and right-click to 
paste it into the URL field.) 

5. Select “New Window (_blank)” in the Target Frame 
field (to prevent users from navigating away from your 
page) and Click OK. 

NOTES: 

 
 Creating a Link to Another MC Unit’s or Department’s CMS Content Block or DMS Document                                                                            

 
For an HTML Content Block 

1. Follow steps 1-3 above. 
2. In step (4.) do not enter the full URL.  (Using “relative” urls will prevent your link from breaking if the 

college moves from the ‘cms’ domain to a ‘www’ domain in the future.) 
 
Instead: 
a. Omit the “root directory” http://cms.montgomerycollege.edu/ and 
b. Enter the only the directories and the content-block ID that follow it.   

For example (Faculty & Staff Tab):  /edu/tertiary1.aspx?urlid=69 
 

3. Select “New Window” and Click OK when finished. 
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 Creating a Link to one of Your Own DMS Document Assets 
 

1. In Edit mode, highlight/select the link - text or image. 

2. Click on Files, Images, Hyperlinks  (If you have a 
popup blocker, hold the shift-key while clicking.) 

3. The Library Window will pop up.  
4. Select the folder containing your assets in the 

directory-tree on the left. 
5. Select “Quicklinks” from the drop-down menu. (Top of 

Library Panel.) Your assets should appear in the list. 
6. Double-click on the name of the asset for your link. 
7. The Editor reopens and displays your linked text or 

image. 
8. By default, the link will open over the top of your 

current page.  To open it in a new browser see below 
“Displaying Your Content in a New Browser Window 

NOTES: 

 
 

 Displaying the Linked Content in a New Browser Window         
 

1. Highlight one of the links that you have already created. 

2. Click the hyperlink button in the toolbar  
3. When the hyperlink dialogue box opens click the “Target Frame” drop-down menu and select 

“New Window (_blank)”.  
 

 Adding a Bookmark (anchor) and a Quick Link to the Bookmark  
 

1. Place your cursor directly to the left of the text or 
image to which you want the hyperlink to “jump.”  
This will be your bookmark (anchor.) 

2. Click the Bookmark icon  in the toolbar and the 
Bookmark naming dialogue will open. 

3. Name the bookmark in the popup dialogue box and 
click Add. 

4. Highlight the text or image that will become the link 
that jumps to the bookmark and in the toolbar. Click 

the hyperlink button.  
5. The Hyperlink dialogue box will open.  Select the 

bookmark name from the Quick Link drop-down 
menu at the bottom and Click OK. 

NOTES: 
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 Removing a Hyperlink or Bookmark                             
            

• In edit-mode, highlight or click into the text or image that is the link you want to remove. 

• Click the Remove Link icon  in the toolbar and the link will be removed. 
 

 

Practice Making Hyperlinks and Bookmarks 
•  Open “My Practice Content Block” in the editor. 
• Follow the instructions for “Practice Making Hyperlinks and Bookmarks.” 
• When finished, click “Check-in” and then preview the content in the Staging Site. 

 
 
Next we will introduce the full explanation of the editor’s Publish, Check-in, Save, and Cancel buttons. 
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We strongly suggest using “Save” while editing and “Check-in” (not “Cancel”) at the end of the editing session. 
 

  Publish:   Save and Publish on the live site, and Make it preview-able

Do not use “Publish” ( use “Check-in” only) until you are ready for your site to go live.  When ready, 
please email OIT Web Services at 

 on the staging site. 

redesign@montgomerycollege.edu . After they publish your initial site, 
you will be free to publish any subsequent pages or edits.  NOTE: Sometimes the “header block” and the 
menu may be posted by the system after a slight delay.   

  Check-in:  Save and Close (Not Publish) on the staging site. Make it preview-able on the staging site, 
Allow co-workers to edit it. Checked-in content will not appear on the “Public” site until you “Publish” it.    
 

  Save and keep editing on the staging site, but do not publish it
 
 “Save” frequently to avoid data-loss due to a power or network outage, or as a result of accidentally 
closing the browser.  

 on the live site 

At the end of an editing session 

 

you can return to folder view in three different 
ways.  We strongly recommend using “Check-in” as opposed to the methods 2 and 3. 

1.  Click “Check-in” (See above. ) The Saved content will have Check-out” status.

2. 

 This prevents co-
workers from editing your content block before you are ready.  There is no button for this status.  It 
can only be applied by explicitly closing the editor-browser after saving. 
Close the editor-browser and log out

3. 

.  The Saved content will have “checked-out” status. If it was 
previously published, the new version will be visible on the staging site but will require “re-
publishing” in order to replace the old version on the live site. 
Click “Cancel” See below.  
 

  Cancel and 
o If it had a “checked-in” status before editing, only the unsaved edits will be lost, and the saved content 

will have “checked-in” status.  

return to the Workarea Content View 

o If it had a “published” status before editing, then all saved and unsaved edits from the session will be 
thrown out

NOTE:  Understanding the Workarea Content View  
After using Publish or Check-in, the Workarea Content View will display your edit. It 

, returning your content to the state and status it was in when you started editing. 

will not display edits after using 
Cancel.  If you use Cancel you will have to return to the folder and reopen the content block to see recently saved edits.   

 

mailto:redesign@montgomerycollege.edu�


Department Web Site Management with the CMS:  In Class Guide 16 

 

 Tables can be used for Simple Content Area and Tabular Data Layouts                 
See the full guidebook for print examples. 
 

 Inserting a Table 

1. In edit-mode place your cursor where you want the top left 
corner of the table to go. 

2. Click on the table icon in the toolbar. 
3. The Insert Table dialogue will open 
4. You may edit the following fields.                                                                                  

a. Size:  Rows and Columns: Enter any number of rows 
and columns  (Remember: The content area is a fixed 
width and tables will not scroll.) 

b. Layout: Width as Percent = % of Content Area  
(NOTE: The CMS fixes your content area to 700 pixels by 
default. Table-width in percent is normally used to allow 
the content to reshape itself when the user changes the 
browser size.  However, since the CMS fixes the size of 
the content-area to an absolute 700 pixels, table-
stretching will not occur.  So, a table-width set at 50% 
will yield identical results to one set at 350 pixels.  See 
the next item.) 

c. Layout: Width as Pixels = size in absolute pixels. 
d. Horizontal Alignment: Selection of left, center, or right 

will cause the table to snap to those respective 
locations within the content-area.  
(NOTE: Alignment has no effect for a table-width of 
100% or 700 pixels.) 
 

5. When finished, click OK in the upper right of the dialogue. 
6. The table will appear in the editor as a gray-lined grid.   
 

NOTES: 

 
 WIMPORTANTG     

• The empty fields in the dialogue box  must remain empty.

• The “use default color” checkbox 

   
must be checked

• When the dialogue box opens, if the fields appear to be other than what you see here, do whatever is 
necessary so that they appear as they do here. If you enter anything in these blue-highlighted fields, your 
table will display in unpredictable ways.   

.   

Practice Inserting a Table 
• Open “Practice Content Block” and follow the instructions for “Practice Inserting a Table.” 
• When finished, do not click “check-in.” Wait for the instructor to present the next 

page. 
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 Default Table Styles:  Edit-View, Workarea Content-View, & Live-View 
This page assumes you have finished the above practice session. 
 
Edit-View:   
After inserting the table in edit-mode, the editor will supply a light gray 
grid corresponding to the row/column and alignment that you specified 
– as an aid to adding content to the table.  However, the default table 
style does not include this grid.  Click “check-in” to see the Workarea 
Content-View. 
 

 

Workarea Content-View:    
When you check-in or publish content, the WYSIWYG editor closes and 
returns to the Workarea Content View display.  Since this is a database 
display, not a browser, it cannot apply styles or formatting to your 
content.  Therefore, the “empty” table does not show up in this view.  If I 
had placed content into it, the content, without styling, would be visible. 
 

 

“Staging Site” and “Public Site” View 
We’ll assume you are logged into the CMS staging area. Paste its URL 
into the address bar. Paste your table’s content-block ID at the end: 
http://staging.montgomerycollege.edu/edu/department.aspx?id=5522 
Hit <RETURN> on your keyboard and you will see a table in the content 
area containing the CMS default table style. (Example on the right.) 
 

• No border or cell-grid. 
CMS Default Table Style 

• Odd numbered rows in light blue and even no. rows in white. 

 

 

Continuation of “Practice Inserting a Table”  
• You may Check-in your content. 
• Note how the table appears in the Workarea Content and Staging Site views. 

 

 

 Styling Table Rows                                                                   
An Example of Styling Table Rows 
In the example below the top row is TableRowDarkBlue.  The second row is TableRowMediumBlue.  The text in row 
1 is styled orange and the text in row 3 is styled red.  Notice how the live view reveals the default row color of light 
blue.  To change a default row color you must apply a custom colors “over” it.   Here is how the table appears in 
each of the three views. 
 
 
 
 

http://staging.montgomerycollege.edu/edu/department.aspx?id=5522�
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EDIT VIEW WORKAREA CONTENT VIEW            LIVE VIEW 

 
  

  

Practice StylingTable Rows  
• Reopen My Practice Content Block.”  
• Follow the instructions for “Practice Styling Table Rows”   

 

 Styling Tables for Columnar Content Layout          
                    

1. Tables can produce columns for horizontal alignment of text and images.   
2. For content layout, you will want to eliminate the borders and default row-colors.   
3. The table-style called “TableNoStyle” can accomplish this.   

 

 
 
 
Instructions:  Styling Tables for columnar Content Layout                                                       
 

1. In edit-mode,  insert a table (This example is a 1-row X 2-column 
table, 100% width, centered.) 

2. GIMPORTANTG  Do not do this now, but the very last thing you will 
do will be to select “TableNoStyle” from the “Apply Style” drop-
down menu.  It makes the table-structure outline invisible and you 
won’t be able to see where the row-cells are located while editing. 

3. Enter the text and insert the images by clicking into the destination 
table-cell and typing or inserting the images.  For practice, provide 
enough text and use “image-right” or “image-left” to see the full 
effect of columnar layout. 

4. When finished, place your cursor in a table row and select 
TableNoStyle from the “Apply Styles” dropdown menu. 

NOTES: 
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 Adjusting Table Column Width                                                   
Quite often you will have to widen one column and contract another.   
 
Instructions:  Adjusting Table Column Width                                                                             
 

1. Click your mouse into the table-cell you want to change  
(NOTE: You only need to change the size of one cell.  The other cell(s) 
will automatically adjust.) 

2. Click the table icon  (See “Inserting a Table” for the full toolbar 
image.)  NOTE:  If your mouse is not within a table-cell, the drop-
down menu properties will be disabled.  

3. Select “Cell Properties…” from the menu (NOTE:  There are other 
options available in the menu for modifying tables.  They are 
currently beyond the scope of this guidebook.) 

4. The Cell Properties dialogue box opens 
IMPORTANT:   The Fields in the Span, Borders, Accessibility, and 
Custom Background must be empty.  If they are not, you should 
delete their contents before continuing. 
 
a. Enter the Layout: Width (select  either percent or pixels) 
b. Check the Word Wrap checkbox 
c. Alignment: Make a selection from both the horizontal and 

vertical drop-down menus. 
d. Click OK. 

 
5. The dialog box will close and changes to the table-cells will be 

displayed in Edit-View.   
6. Checkin your Content Block and then preview it in the staging area. 

NOTES: 

 
NOTE: It may take several attempts at editing a table before the 
staging area view has the look and feel that you are after. 

 Editing the Department Header Area                                    
 

o The Department Header Area automatically appears at the top of each of your pages.  
o Its 3 optional content blocks are already created for you.  (1.) Department Banner Image ( logo or 

banner ) (2.) Department Title (3.) Department SubTitle
o XIMPORTANTXX The content block names should not be changed:  The CMS uses the preset names 

when it loads headers into the browser.  Your header will not display if you change the names. 
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Example contains content-blocks - Banner Image, Department Title, & Department SubTitle 

 

Instructions: 
The Department Banner Image  

1. Click the Department Banner Image content block.  
Remember: do not change the name of the content block. 

2. Click the Edit icon  in the toolbar to open the content 
block in the editor. 

3. Insert the image into the content block, Publish, and 
preview your work in the browser. 

4. IMPORTANT: Allow the CMS to automatically center the 
image. Even though the styles “image-left” or “image-right” 
are available, the CMS will force the image to sit on the line 
above the Department Title.  Maximum width = 950 pixels, 
Height can vary. 

 
The Department Title  
Unlike other text, the Department Title and Department SubTitle have default sizes and colors.  
  

1. Click the name of the Department Title content block.  

2. Click the Edit icon  in the toolbar to open the content 
block in the editor. 

3. Enter the department name into the text field  

 
 

The Department SubTitle  
Follow the same procedure for editing this as you did for the Department  Title.   
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Creating and Editing the Menu Area  
• Only one menu can be used per folder. 
• You can have single or sub-menu items (See the examples) 
• Menu width is fixed by default.  It does not shrink even if 

your menu names are all short.  Long menu-names will 
automatically text-wrap. 

• Menu font is fixed:  Size, style, and color are preset. 
 You only enter text into fields when editing a menu.  

 

 
 

 
Instructions for Building a Single Item Menu                               
 

1. Click the View button in the Contents View of your folder. 
2. Select Menu from the pop-up menu. 
3. The “View All Menus” page opens. 

4. Click   - The “Add Menu” button allows you to add a 

menu.   (NOTE:  The “Back” button  will take you to the 
previous page.) 

5. The “Add Menu” page opens. 

6. Type a Menu Title in the title field and click “Save”  
7. The “View Menu” page will open. 
8. Roll your mouse over the Menu Name.   

          A submenu will pop-up with selections. 
9. Click “Add” to add an item to the menu. 

          (NOTE: The “Reorder”, “Edit”, and “Delete”  
         choices will be covered later.) 

10. The “Add New Item” screen will open.  See the overview 
11. Choose External Hyperlink and Click “Next” 

(Sub Menu will be covered later.) 

NOTES: 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Content Item = one of your HTML content 
blocks, in the main content area 

An overview of the “Add New Item” options 

2. Library Asset = a document or image that will 
open in a new or the current window 

3. External Hyperlink = a non-MC Web page 
that will open in a new or the current 
window 

4.  Sub Menu (covered later) 
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 Adding the “External Hyperlink” Menu Item                                                            

9. After Clicking “Next,” the “Add New Item” screen opens. 
10. Type the title of your menu item in the “Title” field. 
11. Type the Web address for the external hyperlink in the “Link” field. 

12. Click the “Save” Icon  in the toolbar 
13. The “View Menu” page is refreshed. Your new item is added to the menu. 

 
14. Repeat steps 1-13 to add additional external hyperlinks to the menu. 

NOTES: 

 
Adding “Content Item” Menu Items (content-blocks or documents) 

7.  Repeat steps 1-7 above. 
8. Select ‘Content Item’ from the Add New Item dialogue box and Click Next. 
9. A checklist of your content-blocks and assets opens.  Each checkbox you 

check will become a separate menu item.   

10. Check the items and then Click the “Add”   button. The “View Menu” 
page is refreshed, showing your new items added to the menu. 

NOTES: 

 
Preview the menu area:  Open any of your content blocks in the staging browser.   

Instructions for Reordering Menu Items 

1.  Click the View button in the Contents folder-view of your Workarea. 
2. Select Menu from the pop-up menu. 
3. The “View All Menus” page opens, showing the template-name for your 

department menu.  
4. Roll over the Department Menu title and the popup will appear containing 

your menu-editing selections. 
5. Click “Reorder.”  The Reorder Items Page Opens (See steps in image below.)  

NOTES: 

 

 

6.   After saving, the “View Menu Page” will reopen showing the new menu order. 
7. Open a content-block in the Staging Browser to Preview the new menu. 
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Instructions for Building a Menu with Multi-level Sub-menus 

1. Follow steps 1-7 from “Building a Single Item Menu” (above) 
2. In step 8, select “Sub Menu” (the 4th

3. The Add Menu page opens.  
 choice) and Click “Next” 

4. Enter a Title for the sub-menu and Click “Save”. (NOTE: The 
title should reflect a category to which links in the submenu 
belong. For example “Related Web Sites”) 

5. The “View Menu Page” refreshes.  
6. Roll over the submenu title. Its popup edit menu will appear. 
7. At this point, you will add items to the submenu just as you 

added items in step 9-on from “Building a Single Item Menu” 
(above) 

NOTES: 

 

Going Live 

1. Confirm that your site meets the Web standards and guidelines. 

2. After completing your site in the CMS, contact OIT Web Services.  They will do the following: 

a. Publish your Staging site pages to the web.  After that, you will use the “Publish” button to 

make subsequent pages and edits go live. 

b. Activate your home page alias (an easy-to-remember URL) 

c. Integrate your site into the overall .edu site (add a link to your content on the A-Z index and on 

any other landing pages, as needed)  

d. Set up a redirect on your original FTP site (so users who try to access the old URL get redirected 

to the new one)  

e. Archive and take down the original FTP site.  

3. The “Production ” CMS Site is the system seen by the public 

a. The URL is: http://cms.montgomerycollege.edu/edu/ 

b. The Live backup site is not seen.  

  

http://cms.montgomerycollege.edu/oit/NetworkAndComputing.aspx?id=555�
http://cms.montgomerycollege.edu/edu/plain.aspx?id=3162�
http://cms.montgomerycollege.edu/edu/�
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How to Set Up a Department 2 Template Web Site 
This template places a “top menu” immediately below the Department Header. It contains links to department sub-

units or subdivisions and the links do not change as users navigate the site.  Every subdivision of the Web site, including 

the home-page, has unique “left menus” with links to the pages associated with that subdivision. Like the Department1 

Template, the main content area displays the respective pages of each department subdivision. The whole structure of 

a Department 2 Template site would look like this. 

 
 

1. Assign the Department 2 Template to your department folder. 

a. Select the folder in the folder-tree panel on the right of the editor. 

b. Select “View””Folder Properties” from the “View” menu in the Workarea. 

c. When the Folder Properties are displayed, click the “Edit” button in the upper left of the Workarea. 

(Optional: If you want to change the folder name, you can do so now.) 

d. Uncheck “Inherit Parent Template Configuration” in the “Page Templates” area. A confirmation dialog 

box appears. Click OK when asked if you want to “break inheritance.”  The box disappears. 

e. On the “Edit Folder Properties” screen, click the “down-arrow” in the [Select Template] field. 

f. When the list of options opens up, Select “EDU/Department2.aspx”. 

g. Click the “Add” button to the right of the field.  The Department2 template should be added to the 

Page Template Name list above the field. 

h. In the Page Template Name List, click the radio-button next to “EDU/Department2.aspx” 

i. You have now assigned the Department 2 Template to the root department folder. 

j. Scroll to the top of the “Edit Properties” screen and click the “Save” icon. 

 

2. Create the Department “Home Page” content-blocks. 

a. Place the following content In the department root folder 

i. The Department Banner Image (upload the image to the root folder.) 

ii. The Department Title and Department SubTitle content –blocks. 

iii. The Department Landing page content block. 

iv. Any other content-blocks “other than” those of the department‘s subunits. (For example: Meet 

the Staff, Contact Information, Directions, etc.) NOTE:  For now, you can create minimal place 

holders for these pages with simple identifiers in the content. 
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b. Create a Home Page Left Menu containing links to the home page and each of the other content blocks 

in the root folder.  (Refer to the “In Class Guide” for instructions on how to build a menu.) 

i. NOTE:  The title of the left-menu INHERITS its name from your department root folder. You can 

change the name of the folder by editing the folder properties. (See step 1.a to 1.c above.) 

ii. IMPORTANT:  For the menu to work, the title of the menu must be “left menu.” 

 

3. Create the Web Site top menu by populating all subfolders and their left menus 

a. Navigate back to the Department root folder view. 

b. Create a sub-folder for each top-menu item you plan to use. (NewFolder) 

c. In each sub-folder: 

i.  Create place-holder content blocks for each of the pages. 

NOTE: It is wise to use the same content block title for the landing page for each sub-folder. 

ii. Create a menu called “left menu.” (It must be named “left menu” to work.) 

1. NOTE:  The title of the left-menu INHERITS its name from the subfolder name. You can 

change the name of the folder by editing the folder properties. (See step 1.a to 1.c 

above.) 

2. The menu should contain links to each of the sub-folder’s content blocks. 

3. Rename the links so that the names are the appropriate length for a left-menu. 

4. Reorder the links if necessary. 

d. Navigate back to the Department root folder view. 

e. Create a new menu in the root folder called “top menu.” 

i. It must be named “top menu” to work. 

ii. The first item in the top menu should be the Department Landing Page (So that users can 

return there after selecting one of the department’s subdivisions.)  

 

NOTE:  If you do not want a “Home” item in the top menu, the left-menu of each sub-folder 

should have a “Home” link. 

 

iii. The remaining items in the top menu should correspond to  the “landing page” within each of 

your sub-folders. 
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